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Understanding Links 

In this chapter you learn how to: 

• view Links, both Link Sources and Link Targets, 

• understand the Links Window, 

• add a link from paragraph to paragraph, 

• add a link from choice to paragraph, from paragraph to choice, from choice to 
choice, 

• change the type of user-added link, 

• delete user-added links, 

• override master links, and 

• refresh links. 
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Overview 
Links are the way SpecLink changes the system status of related paragraphs when you 
select text. Links are a powerful productivity tool for improving project coordination, 
automatically adding relevant information, and excluding incompatible options. 

You need to understand several basic concepts about the Links function. We recommend 
that you read the "Links Concepts" section of this chapter before you begin using SpecLink 
to create a master project file. 

Links Concepts 
Keep the following basics in mind when working with SpecLink: 

• Any paragraph may be linked to any number of other paragraphs both within the 
same section and in other sections. 

• Links can be made from the sections in the Short Form and PerSpective tabs to the 
SpecLink sections, so that selections made early in the project time line will carry 
through to the later stages of the project. 

• Link sources are paragraphs that are connected by links to the current paragraph. 
Active link sources are paragraphs that are currently selected and active in the 
project, so that their links to all paragraphs, including the current one, are in force. 

• Link targets are paragraphs that would be affected by links from the current 
paragraph if it were selected. 

• Only one link may exist from any source paragraph to a given target paragraph, 
except that there may be multiple links to choices within a paragraph. 

• Active links appear as bold in the Links dialog box. 

• A paragraph may be the target of any number of links from multiple source 
paragraphs. 

• Links act in one direction only and do not result in reciprocal linkage. For example, 
a paragraph that automatically selects another paragraph is not selected 
automatically if its target is chosen first; a separate link acting in the opposite 
direction would be necessary, and this may not always be appropriate. 

• When in a checked-out section, to view links to or from external sections, you will 
need to check the section back in. Links from other sections will remain in effect; 
however, you will not be able to view the link source in the Links dialog box. For 
more information on the Section Check Out feature, see Chapter 9. 

Now look at the basic components of Links. 
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The Links Window - Viewing Links 
The Links window is a “floating” window that can be resized and relocated on the screen. 
Use the Links button on the View Toolbar to open the Links window, or use the Links 
command on the View menu. 

 Links Button 
Click the Links button on the View toolbar to open the Links window and display links for 
the current paragraph. Or select Links from the View menu. The default tab in the Links 
window displays the Source Links; a second tab displays Target Links. 

NOTE: You can move the Links window by clicking on its title bar, holding the left mouse 
button down, and dragging it to a new location. You can also resize it.  

Source Links tab This tab shows paragraphs or choices connected by links to the 
current paragraph. Active links (those currently in force because 
the source paragraphs are active) are indicated by bold font. 

 

Viewing Source Links 

NOTE: If you are in a checked-out section, source links from other sections will not be 
listed. 
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Target Links tab This tab shows paragraphs or choices connected by links from 
the current paragraph that are activated by selection of the 
current paragraph. 

 

Viewing Target Links 

NOTE: If you are in a checked-out section, target links to other sections will not be listed. 

Links Window Information 
For each link, the following information is displayed on the Source Links tab and the Target 
Links tab: 

Influence In the Influence column, the color of the arrow indicates the status 
type (selected, recommended, excluded). See the "Types of Link 
Influences" section of this chapter for details. 

 The direction of the arrow indicates the type of link (arrows pointing 
to the right indicate targets; arrows pointing to the left indicate 
sources). 

 A diamond on either or both sides of the arrow indicates the 
involvement of a choice. More detail about the choice appears in 
the Source or Target window below. See below for more detail. 
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Paragraph In the Paragraph column, the following information appears: 

Section Number The target or source may be in a different 
section, so the section ID is indicated.  

Sequence The sequence number of the target or source 
Number is listed as an aid to locating the paragraph. 

NOTE: If sequence numbers are not currently displayed in the Status Columns portion of 
the Document Panel, from the View menu, choose Display Layout, and then 
choose Sequence Number. 

Specification In the Specification column, the text of the target or source is 
shown to aid in verifying whether the link is appropriate or not. 

NOTE: To see the entire source or target paragraph, use your mouse to "grab" the edge 
of the Links window and enlarge it, or click on the Maximize button. Clicking on 
the Autosize checkbox at the bottom of the Links window will display the entire 
specification text for each paragraph without resizing the window. 

Source The Source information at the bottom of the Links window 
indicates whether the source of the current link is a paragraph or a 
choice. If the source is a choice, the window includes a diagram 
that identifies the choice group, the values of the choice group, and 
the value of the source choice.  

Target The Target information at the bottom of the Links window indicates 
whether the target of the current link is a paragraph or a choice. If 
the target is a choice, the window includes a diagram that identifies 
the choice group, the values of the choice group, and the value of 
the target choice.  

NOTE: Click Close to close the Links window. The next time you open it, the window will 
reappear in the same size and location on the screen. 

Types of Link Influences 
Consistent with the SpecLink color-coded method of selection, the types of Link influences 
are also color-coded.  
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Link - Target Influences 
For Targets, the following types of influences exist: 

 This (green) link changes the status box of the target paragraph to a green 
square. 

 This (red) link changes the status box of the target paragraph to a red stop sign. 

 This (yellow) link changes the status box of the target paragraph to a yellow 
triangle. 

 When the source paragraph is active, a choice is selected in the target 
paragraph. 

 A choice selected in the source paragraph changes the status box of the target 
paragraph to a green square. 

 A choice selected in the source paragraph changes the status box of the target 
paragraph to a red stop sign. 

 A choice selected in the source paragraph changes the status box of the target 
paragraph to a yellow triangle. 

 A choice selected in the source paragraph selects a choice in the target 
paragraph. 

For paragraphs that are active, all targets are in effect (displayed in bold type). For 
paragraphs that are inactive, no targets are in effect (all are potential). 

NOTE: The influence color for links associated with target choices is always black 
because you cannot set the influence; it is either on or off depending on the 
active choice. 

Link - Source Influences 
For Sources, the following indications of influences exist:  

 This (green) link changes the status box of the target paragraph to a green 
square. 

 This (red) link changes the status box of the target paragraph to a red stop sign. 

 This (yellow) link changes the status box of the target paragraph to a yellow 
triangle. 

 A choice selected in the source paragraph changes the status box of the target 
paragraph to a green square. 

 A choice selected in the source paragraph changes the status box of the target 
paragraph to a red stop sign. 
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 A choice selected in the source paragraph changes the status box of the target 
paragraph to a yellow triangle. 

 When the source paragraph is active, a choice is selected in the target 
paragraph. 

 A choice selected in the source paragraph selects a choice in the target 
paragraph. 

For paragraphs whose status box is still neutral , no sources are active. The sources 
listed in Bold type are active and affecting the current paragraph (the target). 

NOTE: The influence color for links associated with target choices is always black 
because you cannot set the influence; it is either on or off depending on the 
active choice. For paragraphs that have been selected, excluded, or 
recommended by the software, at least one source is in effect (shown in bold 
type). 

Link Considerations 
Because a given target paragraph may be acted upon by several links of different types 
(from a number of source paragraphs), the text status and related display modes are 
governed by a hierarchy of consequences: 

• Any text may be selected manually at any time, which overrides any links. 

• Any text may be excluded manually at any time, which also overrides any links. 

• If not selected or excluded manually but acted on by one or more links of the same 
type, the status corresponds to that associated with the link type: Green (Yes), Red 
(No), or Yellow (Maybe).  

• If not selected or excluded manually but acted upon by more than one type of link, 
text status is determined by the following hierarchy, from most to least controlling: 
Red (No), Green (Yes), Yellow (Maybe). In other words, one red link will override 
any number of green or yellow links; one green link will override any number of 
yellow links. 

• If not selected, excluded, or acted upon by any links, the text is available for 
selection by the user. 

• Because the status of a particular paragraph is dependent upon the net effect of all 
currently active links, removal of a particular link by deselection of the source text 
may result in a change in the status of the target paragraph. The software 
calculates the current status of each paragraph after each user action and displays 
the active paragraphs using several cues for ease of identification. Active 
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paragraphs appear in a black font, rather than gray, the associated status columns 
are a dark gray, rather than a light gray, and the status box either has a checkmark, 
a green link indicator, or both. 

Several specific types of links provide intelligence in SpecLink. 

Within each SpecLink specification section: 

• Product specification text in Part 2 makes Yes links to appropriate installation 
requirements in Part 3 and relevant Part 1 requirements, such as submittals and 
quality assurance provisions. 

• Mutually exclusive choices among products or installation methods each have No 
links to the conflicting options, so that selection of any one of them automatically 
excludes the others. 

• Selection of text that contains a reference to a reference standard citation in Part 1 
makes a Yes link to the reference citation. 

Within each PerSpective section: 

• Performance requirements at a paragraph level frequently include Yes links to 
subparagraphs that state the criteria and means of evaluation. 

• Performance requirements frequently include Maybe links to requirements for 
substantiation of performance. 

• Mutually exclusive choices among performance requirements, product choices, or 
methods of installation each have No links to the conflicting options, so that 
selection of any one of them automatically excludes the others. 

• Selection of a product in a “Use” list automatically excludes the same product from 
a “Do Not Use” list, and vice versa. 

• Selection of a method of construction in a “Use” list automatically excludes the 
same method of construction included in a “Do Not Use” list. 

Between sections of the SpecLink tab: 
• Each cross-reference within a section makes a Maybe link to the title of the 

referenced section.  

• Each paragraph that refers to requirements in another section makes the 
appropriate links to change the status of paragraphs in the related section.  

• The Table of Contents for the project is updated automatically as sections are 
completed, including page counts. 

Text can be viewed and selected in any order. However, because of links, certain strategies 
may be more effective than others. It is recommended that you start with PART 2 - 
Products, then move to PART 3 - Execution, and finally to PART 1 - General. The reason 
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for encouraging this order of selection is that PART 2 paragraphs, which deal with products 
and fabrication, always have more definitive links to text in PARTs 1 and 3 than either of 
those parts have to text in PART 2. 

Between sections of the PerSpective tab: 
• Each cross-reference within a section makes a Yes link to the title of the referenced 

section.  

• Each paragraph that refers to requirements in another section makes the 
appropriate links to change the status of paragraphs in the related section.  

• The Table of Contents for the project is updated automatically as sections are 
added to the project. 

• Section 00840 - Referenced Documents is updated automatically by links from any 
active paragraph that mentions a reference standard. 

Text can be viewed and selected in any order. However, because the sections are 
organized hierarchically, you should select and edit the “parent” section before you include 
a lower level section.  This means, for instance, that you should first edit Section C before 
you edit Section C1 or C2.  In turn, C1 should be edited before you edit C11, and so forth. 
We also recommend that performance requirements be edited first in each section, before 
selecting text under Products or Methods of Construction. 

Between the PerSpective, Short Form and SpecLink tabs: 
• Decisions made early in a project on the PerSpective tab are linked to the Short 

Form tab, and selections on that tab are linked to the SpecLink tab, minimizing the 
need for re-entering data as the project moves from one phase to another.  

• Each paragraph on the PerSpective tab that refers to products includes appropriate 
links to paragraphs in the related Short Form section.  

• Paragraphs selected in the Short Form tab have links to corresponding sections in 
the SpecLink tab. 

Adding Links 
SpecLink allows you to add links to any project, but you will probably find this feature to be 
most useful in master project files that are used by a number of people. You can add links 
within a single section, between sections, and between choice options.  

NOTE: If you are in a checked-out section you will need to check the section back in 
before you will be able to add a link to another section. 
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NOTE: To see the effects of added links to other sections immediately, turn of the In-
Memory Linking on the Tools menu. 

Adding Links from Paragraph to Paragraph 
Each paragraph and each choice in a paragraph can have a link to any other paragraph or 
choice. This part of the chapter describes how to add links. 

1. In the Document panel, click on the paragraph that is to be the link source. 

2. Open the Links Window by clicking on the Links button . 

3. Click on the Target Links tab to show link targets for the current paragraph. 

 

Links Window with Target Links Tab Active 

4. Scroll the Document panel to show the paragraph that is to be the link target. 

NOTE: Do NOT move the cursor off the link source. Use the scroll bar and do not click in 
any other paragraph. 

The target can be anywhere in the project, including a different section. If you want to 
link between sections, click the Lock option before opening a new section. Open two 
sections concurrently by minimizing or not maximizing the first section, then click the 
New Window button. Choose a tile option from the Windows Menu. 
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When two sections are open, one is always the "current" window; the title bar is a 
different color. You can switch back and forth between them and as long as you don’t 
click in any text cell the cursor positions stay the same in each. 

5. When the target paragraph is visible, use the RIGHT mouse button to drag from the 
status columns of the target paragraph to the Links Window. 

 Until the mouse is over the Links window, the mouse arrow changes to a circle and bar 
symbol. 

6. Continuing to hold the right mouse button down, drag the cursor to the upper window of 
the Target Links tab of the Links Window, and release the mouse button. When the 
mouse is in the proper part of the Links window, the mouse pointer changes to a hand 
with a sheet of paper. 

 The link is built automatically and appears in the Target Links listing. By default the 
influence is green. 

 

Dragging target to Links dialog box 
A. Dragging status column of target paragraph with RIGHT mouse button; 
B. Mouse pointer changes to circle and bar symbol while dragging; 
C. Mouse pointer changes to hand with sheet of paper in Target Links area, and when 
released new link is created and underlined. 

NOTE: User links are underlined to differentiate them from master links. 

 If the parent of the target paragraph is active, the new link will be activated immediately 
and will appear in bold font in the Links Window. 

7. To change the type of link, double-click on the green arrow in the Influence column. 
Then double-click again. It toggles to red. Another double-click toggles it to yellow. 

A. 
B. 

C.
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Target Links Tab in Links Window, Showing User-Added Link 

Adding Links from Section to Section 
You add links from section to section in the exact same way as you add links from 
paragraph to paragraph. The only difference is that you need to have two windows open, 
one for each section. 

1. With one section open, click on Window | New Window.   

2. In the new window, select the second section you want to work with. It may be 
easier to close the Project Tree panel in both windows, so that you can see as 
much of the Document Panel as possible.   

3. To see both windows at the same time, click on Tile Vertically or Tile Horizontally 
under the Window menu. 

4. Create links as described above. 

Links from Choices 
You can also add links:  

• from Choices to Paragraphs, 

• from Paragraphs to Choices, and 
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• from Choices to Choices. 

You can link a choice to another paragraph. For example, if a choice has two options, you 
can link the first value to one paragraph and the second value to a different paragraph. You 
can also link a paragraph to an embedded choice and link choices to choices. 

Adding Links from Choices to Paragraphs 
1. Click in the paragraph with the embedded choice group.  

2. Add a link to a target paragraph. See "Adding Links from Paragraph to Paragraph". 

3. Click on the link you just established in the Links Window. 

 The lower part of the window lists the available choices in the paragraphs. 

 

Links Window showing choices in Source and Target paragraphs 

4. Under Source, select the choice group that contains the choice you want, then select 
the choice value to become the source of the link. 

 A black diamond appears to the left of the arrow in the upper panel, indicating that a 
choice is the source of the link. 
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Links dialog box showing user-added link from choice to paragraph 

Adding Links from Paragraphs to Choices 
The process is similar to adding links from choices to paragraphs, except that you cannot 
alter the influence of this type of link, which is always a toggle. 

1. Put your cursor on the source paragraph.  

2. Add a link to a target paragraph containing the choice group you wish to influence. See 
the "Adding Links from Paragraph to Paragraph" section in this chapter for details. 

3. Click on the link you just established in the Links Window. 

 Detailed information on the source and target paragraphs for the selected link appears 
in the lower part of the window. 

4. In the Target panel, click on the choice group containing the link you want to toggle, then 
click on the choice value. 
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Links dialog box showing link from paragraph to choice 

 A diamond appears to the right of the arrow in the Influence column, and the arrow turns 
black, indicating that a choice value has been toggled by a link from a paragraph. 

Adding Links from Choices to Choices 
The process is similar to adding links from paragraphs to choices, including the fact that 
you cannot alter the influence of this type of link, which is always a toggle. 

1. In the Document Panel, put your cursor on the source paragraph. 

2. Add a link to a target paragraph containing the choice group you wish to influence. See 
the "Adding Links from Paragraph to Paragraph" section in this chapter for details. 

3. Click on the link you just established in the Links Window. 

 Detailed information on the source and target paragraphs for the selected link appears 
in the lower part of the window. 

4. In the Source panel of the Links Window, click on the choice group containing the 
choice value you want to initiate the link, then click on the appropriate choice value. 

5. In the Target panel, click on the choice group containing the link you want to toggle, then 
click on the appropriate choice value. 

 A diamond appears on either side of the arrow in the Influence column and the arrow 
turns black, indicating a choice-to-choice link has been added. 
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NOTE: Links to choices do not turn on the paragraph containing the target choice.  To 
turn the paragraph on, either select it manually or create a paragraph to 
paragraph link to turn it on. 

 

Links dialog box showing link from a choice in one paragraph to a choice in another paragraph 

Deleting or Overriding Links 
You can delete user-added links, but you cannot delete or alter links in the master 
database. To delete a user-added link, perform the following steps:  

1. Position the cursor in the Document Panel on the paragraph containing the link you 
want to delete. 

2. Click on the Links icon to open the Links Window, and then click on the Target Links tab. 

3. In the Influence column, click on the link you want to delete, then press the Delete key. 

 You will be asked to verify the deletion. When you click Yes, the link will be deleted. 

NOTE: Be certain you want to delete the link before clicking Yes, because you cannot 
UNDO this process. 
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Overriding Master Links 
You cannot delete Master Links, but you can override them. You should be cautious about 
doing so, however, because there usually is a good reason for the link. Look at the 
following scenario to understand how to override master links.  

Scenario: There’s some text in a section that you don’t need or want or is inappropriate for 
the project. The text has been included automatically by a green link, but it seems wrong to 
you. You don’t know why it has been included. What do you do? 

There are two ways to get the text out of the project:  

• Exclude it manually,  

• Examine the links to discover why the text was included, and make necessary 
changes to other selections, 

Excluding the paragraph is simple. Just click on the status box until an X appears . The 
text turns from black to gray and the status columns revert to a light gray. The paragraph is 
now inactive and does not print. 

However, exclusion of this paragraph (manually or by a user-added red link) may mean 
that other paragraphs the software included are now no longer included, because they 
were included by links from the paragraph you have now excluded. If that is appropriate, 
there is no problem. However, it may be better to find out why the software included the 
given paragraph and identify other paragraphs the given paragraph might have included. 
To do so, you will need to view its links, using the procedures described earlier in this 
chapter. 

NOTE: If you are in a checked-out section and the source links tab does not list a link to 
the paragraph, the link is from an external section. Check the section in to view 
the link from the external section. 
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